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DISCLAIMER OF WARRANTY

WVH IS PROVIDED "AS IS" WITHOUT ANY WARRANTIES OR 
CONDITIONS, EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THOSE CONCERNING MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.  NEITHER ANGEL BABUDRO NOR ANYONE ELSE WHO HAS BEEN 
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE
SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THIS SOFTWARE 
EVEN IF ANGEL BABUDRO HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES OR CLAIMS.  IN NO EVENT SHALL THE AUTHOR'S LIABILITY FOR 
ANY DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE 
SOFTWARE, REGARDLESS OF THE FORM OF CLAIM.  THE PERSON USING THE 
SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE 
SOFTWARE.

Some States do not allow the exclusion of the limit of liability for 
consequential or incidental damages, so the above limitation may not apply 
to you.

This agreement shall be governed by the State of Colorado and shall 
inure to the benefit of Angel Babudro and any successors, administrators, 
heirs and assigns.  Any action or proceeding brought by either party against 
the other arising out of or related to this agreement shall be brought only in 
a State or Federal Court of competent jurisdiction located in Delta County, 
Colorado.  The parties hereby consent to in personam jurisdiction of said 
courts.

COPYRIGHT

WVH is owned and copyright (c) 1991-1995 by Angel Babudro, all 
rights reserved.  You may only use and/or distribute WVH under the License 
terms below.

LICENSE

The following terms and conditions apply to the use and/or 
distribution of What Vehicle History?:

1. WVH is being distributed as Shareware; it is not free.  You are 
granted a limited license to use WVH for an evaluation period of up to 60 
days, to determine if it suits your needs.  Any other use of WVH or use past 
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this period requires registration.

2. You may keep as many back-up copies of WVH as you wish.  The 
Registered Edition is limited to simultaneous use on the number of 
computers indicated on the Use License.  The Unregistered Edition may be 
used on any number of computers for the purpose of evaluation as specified 
in paragraph (1).

3. All files originally distributed as part of the package (including this 
notice) must be included without modification.  The complete list of files can 
be found in the PACKING.LST file which is part of this package.  The 
Registered Edition CONFIG.WVH file is NOT to be distributed.

4. Individual users may freely copy this disk and share it with friends, 
family, and acquaintances.  Non-profit groups (including user groups and 
BBSs) may distribute copies of this disk.  A fee of no more than $5 may be 
charged to cover disk copying costs.  If the files on this disk have dates more
than a year old please contact the author for a free update to the current 
version.

5. Disk distributors and dealers must have written permission before 
selling copies of this software unless the author has uploaded the software 
directly to your BBS or Internet site.  When you contact me you will receive a 
free copy of the latest version and you will be placed on my mailing list to 
receive updates as they are released.  Disk distributors may charge no more 
than $10 per disk (floppy disk or CD-ROM) which contains this software.  If, 
as a distributor, you supply copies to other resellers, the end price to the 
user may not exceed $10.

6. You must obtain written permission prior to distribution in 
conjunction with any other product or service (e.g., placing on new computer
systems, providing in conjunction with a seminar, etc.).

7. If the software is packaged for retail sale the packaging must 
explain that the software is Shareware, that the purchaser is receiving a trial 
version, and that use beyond the trial period requires registration with the 
author.

8. You must immediately stop selling/distributing copies of this 
software upon notice from the author.
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TECHNICAL SUPPORT (HOW TO REACH ME)

If you have questions or need help, just send a note to me through 
the mail or a BBS listed below.  Registered users, those intending to register 
within 30 days, vendors, and sysops may contact me via telephone as well.  
Sysops and shareware vendors please see VENDOR.DOC for distribution 
information.

Mail Angel Babudro, "Organic Computer Wizardry", 
PO Box 132, Paonia, CO 81428 USA

Phone (970) 527-6756 Tue-Fri 10am-6pm Mountain Time
("970" is a new area code for Colorado; if it doesn't 
work try "303" instead)

I am normally available by phone during the hours stated above.  If 
you get the answering machine please leave a message.  Unregistered users:
please try again later - I am happy to answer your questions but I cannot 
afford to pay for the call.

Official Distribution Bulletin Boards

My software packages are "free" downloads on the BBSs listed 
below - you need not subscribe to download my shareware (although other 
files or functions may require subscription).  I use the first name "Angelo" on 
BBSs since it avoids gender confusion (I'm used to both names anyway).  
Scan for the file name WVH*.* to locate the latest version.

West Coast Expanding Horizons (CO) 14.4k V.32 (970) 241-2847
This is my local BBS so it is the one I most often update 

and check for messages.  The first time on you will have to fill
out the registration form.

From the main menu:
* Enter "OCW" to join the Organic Computer Wizardry 

conference where all the latest files are stored.
* Enter "F" to view the list of available files
* Enter "E Angelo Babudro" to post messages for me

Midwest Rusty 'n Edie's (OH) USR HST 16.8 (216) 726-1804
USR V.Everything 28.8 (216) 726-3628

Hayes 28.8 (216) 726-3619
ZyXel 19.2k v.32/v.32bis (216) 726-3620

2400/v.32/v.32bis (216) 726-2620
--
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CompuCom SpeedModem (216) 726-3584

You will have to subscribe in order to download updates from 
Rusy 'n Edie's, although I believe they give a trial subscription
the first time you log on.

East CoastExcalibur (Central NY) USR Dual (315) 736-3792
FREQ (File REQuest) from this board via RBBS address 

A:954/401, FIDO address 1:26501, or I.C. Net address 
91:315/101.

WhiTech BBS (NC)ZyXEL 14.4 V32b/V42b (910) 944-1165
File Request (FREQ) via Fido address 1:3636/2.

Software Creations (Mass.)
2400/9600/14.4 USR HST Dual Standard (508) 368-7036
2400/9600/14.4/28.8 USR V.Everything (508) 365-6604

This BBS offers about 130 phone lines and tons of Shareware.
They call it "Home of the Authors."  It's also home of Night 
Owl CD-ROM.  I believe you will need to subscribe in order to 
download my Shareware from this BBS.

ORDERING METHODS AND REGISTRATION FEES

WVH has been under constant development since 1991 in the 
hopes that many people will be willing to pay for a small part of the 
development.  If you use this software past the 60-day trial period I ask that 
you pay the registration fee.  There are many benefits to registering WVH, as
explained in the following section.

Benefits of Registration

The Shareware (unregistered) version of WVH is fully functional so 
that you may try all of its features and know exactly for what you are paying.
Past the 60-day evaluation period WVH will display reminders to register your
copy or discontinue use of the software, but it will always continue to be fully
functional.

When you register you have the following benefits:

- You get the latest version with the latest features and 
enhancements direct from the author.
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- You get thorough manual, including an introductory course in 

using computers with sections on hardware, software, and DOS, in addition 
to WVH.

- Telephone support - you can talk to the software author who can 
help you right away and is committed to making the software work well for 
you.

- Updates are free or very low cost - get them from a local BBS or 
Shareware vendor, or direct from the author for just $4 plus shipping. As new
features are added, WVH's price is sometimes adjusted to reflect the 
dramatic increase in its value to users. By registering now, you pay the 
current (low) price and are entitled to the higher-priced features.

- You can subscribe to receive updates & upgrades as soon as they 
are released so you will always have the latest features & enhancements.

- The Shareware License display and Unregistered Edition delay go 
away.

- It rewards the author for thousands of hours of software 
development done without pay and from which you are deriving benefit.  It's 
the right thing to do and will surely come back to you in blessings & good 
karma.

How To Order

Send cash, check, or money order in U.S. funds (Canadians may send 
Canadian funds).  Payment must accompany Purchase Orders.  Since you are
(and have been) using the Unregistered Edition, please consider it the case 
that you are paying for already-delivered merchandise.

If you prefer to use a credit card, you can order WVH from Public 
(software) Library with your MC, Visa, AmEx, or Discover card by calling 800-
242-4PsL (from overseas: 713-524-6394) or by FAX to 713-524-6398 or by 
CompuServe to 71355,470.  THESE NUMBERS ARE FOR ORDERING ONLY.  I 
CANNOT be reached at those numbers.  To contact me for information about 
dealer pricing, volume discounts, site licensing, the status of shipment of the
product, the latest version number, or for technical information, call 970-527-
6756 or write me at PO Box 132, Paonia, CO USA 81428.  The idea behind 
Shareware is that you try it before buying and, therefore, product returns are 
not allowed.

When ordering from PsL ask for product #11518.

Pricing
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Use License with Disk, Manual, and Computer Course — $99.  License 

to use WVH on one computer along with the latest Registered Edition 
on disk with automated installation, the latest version of this 
documentation on disk, notification of major updates, a printed 3-ring-
bound manual, and life-time technical support.  The manual contains 
an introductory course in computers plus a complete guide to using 
WVH.  The course contains introductory-level material covering 
computer components (hardware), DOS & software basics, using 
BBSs, etc.  Manuals are printed on recycled or tree-free (hemp & 
cereal straw) paper.

Wholesale & OEM ── If you want to resell WVH or bundle it with your 
product or service please write me with your idea.

Site License ── If your firm has multiple computers or network stations on 
which WVH will be used you may purchase a Use License for the first 
copy (explained above) plus a Site License.  With a site license you 
get a discount based on the number of computers you are licensing, 
for which you received a disk for each computer and up to 10 printed 
manuals (additional printed manuals may be purchased as well).  
Discounts range from 30% to 80%.  Use WVH's Site License option on 
the Help menu to print the Site License order form.

Free Updates — When you register I will send you a "key" which will allow 
future releases to work as Registered Editions.  You can download 
from a BBS or otherwise obtain an updated copy and it will recognize 
your registration key.1

Updates Through The Mail ── An update disk with the latest versions of all
my shareware costs $4 plus shipping charge.

Update Subscription ── I will send important updates as they are released.
In return you will be expected to send $4 plus shipping to me within 
30 days or return the disk to cancel this service.  There is no time 
commitment and this subscription can be cancelled by either party at 
any time with written notice.

Prices and specifications are subject to change without notice.  
1When you share copies with BBSs and others be sure to delete your 
CONFIG.* file from those copies.  Not only does it contain all the settings on 
your system and certain pieces of your data, but it also contains your 
registration key and your name.
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Vendors and sysops see VENDOR.DOC and SYSOP.DOC.

Register the Shareware you use.
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INVOICE & REGISTRATION

Credit card orders see "How To Order" above

REMIT TO: FROM:

Angel Babudro Name___________________________
"Organic Computer Wizardry"
PO Box 132 Company________________________
Paonia, CO  81428
USA Address________________________

_______________________________

Phone__________________________

Use License Registration, disk, & manual $99

Shipping & Continental U.S. - add $5
Handling Canada, AK, HI, VI, PR - add $7

Outside U.S.A. & Canada - add $22 _______

*** T O T A L  = $_______

Update Subscription
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Send WVH updates 4 to 8 times per year.  In return I will pay $4 plus shipping
within 30 days or return the disk to cancel the subscription.
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YES [__]

NO [__]

Disk size [__] 5¼" [__] 3½"
Drive density [__] Low (DD) required [__] High (HD) okay
FDFORMAT/FDREAD [__] FDFORMAT extended densities okay
Do you have a CDROM? [__] Yes [__] No

Printer make(s) & model(s)______________________________________

Which version are you using now?________________________________

I got it from __BBS __Vendor __Other   Name_____________________

I saw a review in_______________________________________________

Upon receipt of this paid invoice the latest Registered Edition disk and any 
options ordered above will be sent.  Mail with your cash, check, or money 
order in U.S. funds (Canadians may send U.S. equivalent in Cdn$).  Put 
comments on back.  Allow 1-4 weeks for delivery.  Thank you for registering!
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WHAT DOES THIS SOFTWARE DO?

What Vehicle History? (WVH) was originally designed in October 1991 
to track maintenance records for construction equipment.  Over the years it 
has been expanded to track the maintenance history of just about any 
ground-based mechanical devices - cars, trucks, tractors, motorcycles, big 
rigs, power generators, or anything else that is tracked by miles or hours.  
(An aviation version is being researched - please write if you are interested in
this.)  Each "vehicle" has an owner, division, or department identified with it, 
which makes WVH perfect for companies who own many vehicles or shops 
who maintain other people's vehicles.

WVH will track parts, labour, and comments pertaining to each 
service incident for a vehicle.  In addition, you may enter your parts 
inventory and WVH will track stock levels and sales history (including profit 
margin) on parts.

SYSTEM REQUIREMENTS & LIMITS

Computer Hardware Requirements

In order to use WVH here is what you will need:

* An 8088/80x86 computer2
* At least one disk drive with at least 720k of free storage3
* MS/PC-DOS 3.1 or higher, DR-DOS 6 or higher, OS/2 2.14

* At least 400k free RAM5

* A printer if you wish to print reports

Here is what you don't need (i.e., these things don't make any 
difference in how quickly WVH operates):
2An 80286 or newer computer will operate much more quickly than an 8088 
or 8086.
3Although WVH can be run on floppy disk, for adequate speed a hard disk will
most likely be needed.
4Recommended DOS versions are:  PC-DOS 3.3, 5.0, or 6.1 or higher; MS-DOS
3.3, 5.0, or 6.2 or higher; DR-DOS/Novell DOS 7; OS/2 version 2.1 or higher.
5This is the amount of free conventional (or "lower") memory required.  Your
computer may also have High/UMB, EMS, and/or XMS (or "upper") memory.  
If you have about 500kb of free upper memory, WVH will use it to operate 
more quickly.
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* A numeric co-processor
* More than 500kb of EMS memory

Storage Requirements

Although the system is capable of handling 5.5 millions entries per 
file, you would need a super-computer or a lot of time to manage it.  Here are
some practical guidelines for your computer system:

PC/XT (8088 or 8086) - perhaps 10 vehicles
80286 - 10 to 20 vehicles
80386 - 20 to 100 vehicles
80486 - Over 100 vehicles

These are just recommendations, though.  You can track a thousand 
vehicles on a PC/XT if you want to, but it will operate slowly due to the slow 
speed of the hard disk and processor.

Using on a Network

WVH does not yet use record locking so it is not suitable for use on a 
network.  If only one person will use WVH at any one time then it will work 
fine on a network.

WVH allows shared access to the programme files, which means that 
you can have more than one user running WVH as long as each user is using 
a different set of data files.  You create new data files by creating a new 
directory, changing to that directory, and then starting WVH.  For example, if 
you have two departments which repair and track the records for their own 
vehicles you can install the WVH programme in the network drive F:\WVH.  
Next you could create two directories called F:\WVH\DEPT-1 and F:\WVH\
DEPT-2.  To begin using WVH with Department-1's data files you would "CD \
WVH\DEPT-1" and then "..\WVH" (or "\WVH\WVH") to run the programme.

Record locking can be set up by request.  If you want to run WVH on a
network, having multiple stations access the same data base of vehicles, 
please write.  The registration fee for a network version is contained in the 
Site License Form which can be printed from WVH's Help menu.

Using with MS Windows

WVH can be run as a DOS application under Windows 3.1 although it 
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is not a Windows application (in other words, it runs the same in DOS or 
Windows).  If you don't use Windows or use it only occasionally (as I do), then
use WVH from DOS since it will work faster without Windows' overhead.  If 
you normally have Windows loaded, however, then go ahead and set up an 
icon for WVH.  To do this, highlight or create a group, then use File/New to 
create a program item and define it as C:\WVH\WVH.EXE (or whatever 
directory you are using) and set the data directory to C:\WVH or some other, 
as you desire.

Using with 4DOS

WVH has been tested on 4DOS versions 4.0 through 5.5.  No special 
considerations or procedures are necessary.

Operating Limits

WVH has certain operational limits of which you may want to be 
aware.

* Except as otherwise noted, the maximum number of records in 
any file is 5.5 million

* The maintenance (service) incidences may not exceed 300 for nay
one vehicle.

* Each maintenance incident may contain up to 99 parts.

RUNNING What Vehicle History? FOR THE FIRST TIME

Quick Start

To get started in a hurry just type "WVH" from the DOS prompt and 
set each of the Preferences screens.  Use a mouse or keyboard commands to
move around.  To get help while on any data entry screen:  position the 
cursor (using keyboard arrows or move mouse cursor then click the left 
button) on the item you want more information about, then press the F1 key.

____ Enter your customers first, then mechanics (or service providers), 
vehicles, and service categories.

____ If you don't care about tracking maintenance by service 
category (e.g., Brakes, Transmission, etc.) then just enter one 
category called, "General" or something like that.
____ Likewise, if you don't want to track mechanics or service 
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providers then enter a single service provider (e.g., code "1", name 
"General") and leave the hourly rate set to zero (you can enter the 
hourly rate as you enter each maintenance record.
____ Set "Allow labor amount to be entered on maintenance 
screen" to "Yes" on the Sales Tax Preferences screen or you won't be 
able to change the dollar amount.

Installation

Before you can use WVH you will have to install it on your hard disk or
create a working floppy disk.  Since almost no business uses dual floppy disk 
systems anymore I won't bother to explain the procedure here.  If you have a
lap-top computer with dual floppy disks simply place the necessary files (as 
listed above) on one disk and use the other one for data files.  The full 
Printed Manual contains details on this.  Contact me if you need help with 
this in order to evaluate WVH before registering.

If you received your copy of WVH on floppy disk it came with an 
INSTALL programme.  If INSTALL.EXE or any other of the files which make up 
the software are not on your disk please contact me so I can make the 
distributor aware of the problem.

To use the automated installation programme, go to the DOS prompt 
(usually "C:\>" or something similar), and type "d:INSTALL" where "d:" is the 
letter of the floppy disk drive with the WVH disk (e.g., "A:INSTALL" to install 
from floppy A:).  You will be asked to supply the destination drive and 
directory.  If you have an existing version of the software on disk you will be 
informed that it will be updated with the new disk.

After INSTALL is finished you will see some helpful information for 
setting up your computer well, and directions on how to run WVH.  A batch 
file called WVH.BAT is created in your root directory if you so permit, and 
your CONFIG.SYS and AUTOEXEC.BAT files are not touched at all, not one 
little bit — I wouldn't invade your system that way.

While in the root directory you just type "WVH" to start the 
programme.  WVH is a batch file which merely changes to the proper drive & 
directory then runs WVH.  You can delete this file if you are using a menu or 
would rather type the commands yourself.

Using the Menus
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WVH uses the familiar pull-down menus which are common to 

QuickBASIC, Windows, and Macintosh applications.  Basically, there is a 
horizontal menu of choices -- File, Data Entry, etc.  Under each of the 
horizontal choices is a menu of functions pertaining to that item -- it is a two-
dimensional menu, in other words.

There are two ways to select an item from the main menu:

1. Press the letter which is highlighted in the option description
2. Use the Up/Down/Right/Left arrows to highlight the option you 

want then press ENTER (a.k.a. RETURN or CR).

Some menus have no highlighted options.  On these you must use the
arrow keys to highlight your choice then press ENTER.

If you want to cancel an operation you selected, just press the Esc 
("Escape") key.

Using Information Windows

Whenever you press the F1 (help) key, use WVH's Help Index, and at 
many times in the programme's execution, you will see a window of 
information "pop up" on the screen.  These information windows follow these 
guidelines of operation:

* To close the window or to cancel whatever operation was being 
attempted, press the Esc (escape) key or click with the mouse on the symbol
in the upper left corner of the window.

* If there are only affirmative and negative buttons (e.g., Yes/No, 
Continue/Stop, etc.) then the ENTER (or RETURN) key chooses the affirmative
response (Yes, Continue, etc.) and the Esc key chooses the negative 
response (No, Stop, etc.).

* To use one of the functions indicated by the buttons at the bottom
of the window you may press the highlighted letter of the button (for 
example, the "Index" button shows the letter "I" in bright white) or you may 
press the Tab or BackTab keys to highlight the button you want followed by 
pressing the ENTER key.

MANAGING FILES
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The choices under the File menu have to do with your system set-up, 

file management, and ending the programme.

Copying Files

To copy a particular file between computers (say, a lap-top and desk-
top) you will need to copy more than just the data file for proper operation.  
A complete set of data consists of:

1. The data file (ending in WVH)
2. The index files (ending in IX*)

You can re-create the index files if you do not copy them, but it is 
usually faster to copy them.  If the GROUPS files are missing you will not be 
able to select records by group nor will you be able to change or view the 
group settings.

The easiest way to be sure you have it all is to copy all of your data 
files using the Copy Files option under the File menu.  Alternately, you can 
use the DOS copy command to copy the files outlined above.

Using DOS Commands

The Copy Files function is described in the next section.  Here is 
an example using DOS:  Let's say you have several mailing list files 
and you only want to put one of them on a 3.5" floppy to use on your 
lap-top.  Let's call the list MYLIST and assume that your 3.5" disk drive
is B:

1. Go to your WML directory on the hard disk (e.g., CD \WML)
2. COPY MYLIST.* B: to copy the data & index files
3. COPY GROUPS.* B: to copy the group definitions

Using the Back-up option

Your computer is a machine and one day it will probably break 
down.  File/Back-up protects your information by making a copy of it 
on another disk.  To determine when it is time to make a back-up copy
of your information consider a hard disk failure.  Feeling suicidal?  It's 
time to make a back-up copy.

When using floppy disks remember that a disk must be formatted 
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before use.  You can use the same back-up disk or directory over and 
over again - each new copy will over-write the old one - but it is a 
good idea to alternate at least three back-up copies just in case there 
is a problem (such as a power outage) while you are creating a copy.  
In this case if the computer "crashed" and the back-up was 
incomplete you would still have two other back-up copies on which to 
rely.

Once you select the Back-up option you will see a menu of up to 
four choices of methods to use when backing-up and restoring:  DOS 
COPY, ARJ, LHARC, or PKZIP.  The options for ARJ, LHARC, and PKZIP 
will only appear if WVH is able to locate them using your search path 
and if there is enough free memory to use them.  I recommend LHARC
since it uses a fairly small amount of memory, it's reliable, and it's 
Freeware (the others are Shareware so they should be registered).

Using compression software packs more information in less space 
(so you can use fewer floppy disks) but requires more memory (RAM). 
The compression software WML is programmed to use and their 
memory requirements are as follows:

ARJ 2.41 needs at least 300k free
LHARC 2.13 needs at least 189k free
PKZip 2.04g needs at least 157k free

After you select File/Back-up a summary window pops open and a 
menu of methods will be presented, starting with "DOS Copy" and 
including each compression technique which is found on your 
computer (using your DOS PATH setting) and for which you have 
enough free memory.  Once you choose a method you are asked to 
enter the back-up destination (which is typically a floppy disk drive, 
such as A:, but you may decide to back-up to another hard disk, a 
network drive, etc.).  All WML data files will then be backed-up to the 
destination disk and directory using the method shown in the window.

Restoring files from a back-up copy

If you ever need to recover data files from a floppy disk you made 
using the File/Back-up command (above), just place the floppy disk in 
its drive and select File/Restore.  The first thing you will be asked is to
specify the disk drive from which to restore files.  Once you highlight 
a drive and press ENTER the list of files on that disk will be shown - 
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individual data files as well as any compressed archives.

Highlight each file you wish to restore and press the SpaceBar 
key; you will see an arrow appear next to each file as it is selected.  If 
you change your mind, just press the SpaceBar again and the arrow 
will go away, indicating that the file will not be restored.  Alternately, 
you may use the mouse and click the left button instead of using the 
arrow keys and SpaceBar.

Once you have selected all the files you wish to restore press the 
ENTER key or click on the "Ok" button with a mouse.  Each file will be 
copied into the current data directory.6  Any compressed archives 
being restored will automatically be expanded.

Formatting Floppy Disks

This option is for those times when you have decided to make a back-
up copy of your data but don't have a formatted disk handy.  File/Format 
Floppies lets you format a floppy disk to your computer's standard density 
without exiting WVH.  If you have a high density drive you can only format 
high density disks (in other words, WVH doesn't pass any parameters to DOS
FORMAT).

If you have What Floppy Format? (WFF.EXE) available somewhere in 
your search path WVH will automatically access it for formatting floppy disks 
(so you can do whatever you want).  You will receive a complimentary copy 
of the latest version of WFF with your WVH registration.

Re-Indexing Files

If you ever notice that information is missing or appears in any way 
wrong, it is probably because something has damaged an index file.  WVH 
will automatically catch and fix most index problems (like if power goes out 
in the middle of the programme), but there are times when only you will 
know that the file indices need to be re-built.

One common example would be if you restored files from a back-up 
disk.  When you make a back-up (using WVH's File/Back-up option) you are 
6The directory from which WVH is started is considered the data directory - it 
is where the data files are stored.  For example, if you are in the C:\WVH\
DATA directory and you run WVH from there, then files will be created in, 
backed-up from, and restored to this directory.
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only storing the data files.  This saves space on your back-up disk.  However,
it means that if you restore from a back-up the index files may be mis-
matched to the files.  So you would use the File/Re-Index option.

If you have large files (thousands of records) re-indexing can take a 
minute or more, depending on your computer's speed.  Aside from that, 
though, it is harmless to re-index as often as you like.

Packing Files

Whenever you delete information from the files WVH marks the "slot" 
(record) in the files as being "available" so that the next new piece of 
information will use that slot.  If you delete a lot of information (for example, 
if you delete a vehicle that had a lot of service history & parts information) 
there may be a lot of disk space being used to store old information.  This is 
where pack comes in handy.

Packing makes a new copy of all of your files which does not include 
deleted records.  For every deleted record between 128 and 512 bytes of 
disk space will be freed.

DATA ENTRY

This menu of What Vehicle History? lets you enter vehicles, 
mechanics and other information into the data base.  The Data Entry menu is
split into three sections:

1. Regular (on-going) data entry for vehicle service information

2. One-time data entry for vehicles, mechanics, departments, and 
service codes

3. Rarely needed data entry (schedule next maintenance) -- this 
function is run automatically after you enter service for a vehicle, so you 
would normally not need to access the function directly.

The Maintenance Scheduling portion of WVH is not yet completed.

All data entry screens use the same method of asking you to choose a
code (vehicle, service type, etc.).  There are two windows on the screen: the 
left-hand one showing the codes and the right-hand one showing the details.
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As you move through the codes in the left-hand window, WVH shows 

you the details for the code which is highlighted.  You move with the arrow 
keys, PgUp and PgDn keys, or by pressing the letter or number of a code.  
For example, if you press the "G" key WVH will jump to codes beginning with 
the letter "G".  If there are no codes that begin with "G" the next code after 
"G" will be highlighted.

You can back-up one step (cancel an operation) by pressing the Esc 
key.  Otherwise, just press ENTER to select the code which is highlighted and 
continue with an operation.

Service Information

This will likely be the function you use the most in WVH.  After you 
have set up your vehicles, owners, etc., this is where you enter the actual 
service information.

Once you select this option you will see the menu of vehicle choices.  
To quit just press the Esc (Escape) key, otherwise highlight a vehicle and 
press ENTER.

Next you will see the menu of service types.  Choose a service type 
which describes the information you are going to enter and press the ENTER 
key.

If there is already some service information for that vehicle then you 
will see a menu of dates.  The first item in the menu is "New date."  Highlight
your choice and press ENTER.

Finally you are on the service entry screen.  There are three windows 
here:  One for parts, one for comments, and one for everything else.  You can
jump between the windows using the F6 (Jump) key.  Within a window use 
the arrow keys to move around.  When you are finished entering information 
press the F7 key to save it.

When you exit the service screen you are back at the vehicle menu 
(as above) and the cycle starts over.  Just press the Esc key to stop entering 
service information.

Customers/Departments, Mechanics, Service Types, and 
Vehicles
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These data entry windows all work similarly.  You will see two 

windows:  One on the left which has codes, and one on the right which has 
the details about the highlighted code.

Highlight a code and press ENTER to edit it's information (in the right-
hand window).  To enter a new code press the Ins (insert) key.  To delete 
(erase) a code press the Del (delete) key.

The codes you define can contain up to five letters, numbers, or 
symbols.  Only upper-case letters are used.  "AG-5" and "AG05" are both 
valid codes, though "AG05" has room for 100 variations while "AG-5" has 
room for 10 variations.  It's a good idea to give some thought to your coding 
system before entering all of your data!

WVH sorts codes in typical ASCII fashion.  One character at a time is 
compared, going left to right.  For example, here is a list of codes in ASCII 
order:

1A
A001 It is best to pad your numbers
A002 with zeroes (like these three examples)
A015 so they come out in order.
A1
A100
A1000
A2
B001

Service Types examples:  Use whatever works for you.  If you have an 
existing system, just use those same numbers or letters.  Perhaps you have 
abbreviations you use on invoices.  You can use "BR" for "Brakes", or you 
might just have service type "1" for all types of service if you don't care to 
separate the service history by service types.  Avoid getting too detailed 
because you will have to enter a separate service record for each type of 
service you want to track.  This might mean splitting one service into two 
entries - perhaps you replaced a radiator and replaced brake pads at the 
same time.  If you want to print a report in the future which shows just the 
brake work (or whatever), then make a service type for it.

Inventory
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This screen lets you enter your parts inventory into WVH.  Once you 

set up inventory items you may enter an item number when entering vehicle
service information (in the parts window) rather than entering the part 
descriptions and selling prices manually.  This not only makes entering parts 
data more convenient, but it also helps avoid typing errors.

The inventory window works much like the other data entry screens 
except that a list of inventory codes is not always visible on the screen.  
Instead WVH waits for you to enter a part code and, once you do, it checks to
see if it is already on file.  If the code is on file, WVH displays the information 
for that part and you may edit it.  If you enter a new part code, WVH lets you 
fill in the information for it.

You may look up an inventory code by pressing the F2 (Find) key.  This
pops open a window which shows the inventory codes on file; you can move 
through this list to find the desired code then press ENTER to choose it.

While the cursor is position on any of the fields you can press the F1 
key to get information about the purpose and use of the field.

Inventory Receipts & Depletions

The purpose of this window is to let you enter changes to your 
inventory and have those changes automatically calculated in your 
inventory's figures & history.  For example, if you are tracking your inventory 
using the Average Cost method then moving items in or out of inventory 
means that a new average cost must be calculated.  Rather than doing this 
yourself and entering the new cost figure, you can use the Receipts & 
Depletions function to transfer items and WVH will do the calculating for you.

To use this screen just enter a valid inventory code (or use the F2 key 
to look-up an inventory code) and WVH will display the current quantity on-
hand and quantity on order.  You may then enter a positive or negative 
change to the quantity figures and you may also enter the value (cost or 
selling price) at which the inventory was sold or acquired.

When you are finished entering figures for an inventory item press the
F7 key to save the changes.  WVH will then present a blank form for you to 
enter another inventory code.  When you are finished with this window press 
the Esc key to return to the top menu.
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REPORTS

Highlight the report you want and follow the instructions on the 
screen.  For reports which ask for dates - enter the date in month-day-year 
order, entering just the numbers and using a 4-digit year.

You can choose to print a report on the screen, on your printer, or to a
disk file.  If your print to a disk file you will be asked for a file name (which 
may include the drive and path, if necessary) and the file will be created 
without any printer control codes.

PREFERENCES

The Preferences menu contains options which help you customize the 
operation of WVH and set necessary parameters, such as the type of printer 
you have.  All of these screens work like any of the data entry screens:  Use 
the arrows to move around or click with a mouse, press F1 to get help on any
item, and watch the bottom of the screen for command keys.

Check each Preferences screen before making use of WVH, otherwise 
something might seem wrong with the software whereas it is due to the set 
of conditions under which WVH is operating.

Inventory

This screen controls how your parts inventory will be handled.  The 
first item, "Print invoice after entering maintenance" is set to "Yes" or "No" to
tell WVH whether you want an invoice printed after you enter service 
information.  If you do not print invoices then you can use the Billing options 
(on the reports menu) to print statements.  If you choose to print invoices 
then the next line becomes active, on which you may enter the next invoice 
number WVH is to use.

Next is an option for movement tracking.  You can track your parts 
inventory by averaging cost figures or by tracking the last four costs and 
using the parts on a First-In-First-Out basis (FIFO, the most common, oldest 
parts are used first) or a Last-In-First-Out basis (LIFO, newest parts are used 
first).

Next you can enter the default minimum and maximum inventory 
levels.  If the majority of parts you will be entering are not in stock (such as if
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you were entering a parts distributor's entire catalogue into WVH), you will 
want to set the default Min and Max to zero, since that is what you'll want 
most of the time.  If most (or all) of the parts you'll enter into WVH are in 
stock then you'll probably want to default minimum to be one (or two or 
whatever is normal for you).

The Default Selling Price determines which price will be assumed 
when you enter new customers into WVH.  If you leave this set to "Standard" 
then every new customer will be set to use the "Standard" price for parts 
unless you change it.  Within a corporate environment you will probably use 
"Cost + Overhead" and set the overhead to 0% if you do not mark up the 
parts at all.

The "Warn if out of stock?" option, when set to "Yes", will pop open a 
window telling you that an item is out of stock when you try and enter it in a 
maintenance record.  If you go to the computer first (before checking stock), 
then set this to "Yes"; if you pull the part from stock first and enter the data 
in the computer after the work is finished, then you might want to set this to 
"No."  You can change this setting whenever you want, so experiment to see 
which works better for you.

The last four fields are G/L account numbers for printing on reports.  
This is just to place the account numbers on reports so that the bookkeeper 
has them handy.

Miscellaneous

Country setting

This setting is used only to determine the spelling of "labour" 
versus "labor" and the date format (mm/dd/yyyy or dd-mm-yyyy or 
yyyy.mm.dd).

License State/Province

This is the State or Province abbreviation which is will be placed 
in each vehicle's record (you can change it if necessary).  If most or 
all of the vehicles you work on are licensed in one State or Province, 
set this to the two-letter code.  If the license plates are from many 
places or the equipment you work on have no license plates, then 
leave this field blank.
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Alert Tone

When some type of error or warning message is displayed on the
screen, you reach the end of a field, press a wrong letter in a menu, 
etc., WVH can alert you with one of three sounds or you may select 
"No sound" for silent operation.

Other ID Titles

The last nine fields have room for you to enter a title for each of 
the nine extra serial number/ID fields for each vehicle.  For example, 
you may want to keep track of the Engine Frame serial number, so 
you could set the title for the first one to "Engine Frame."

Printer

WVH lets you use a laser or dot matrix printer, but you must first 
define it and the fonts you want to use for printing.  Until you define your 
printer and fonts there will be a flashing message at the bottom of the 
screen and you will not be able to print anything.

The Preferences/Printer window shows the current settings.  Use the 
arrow keys to move around, and press the F3 key to change anything.  For 
example, to set your Title Font move the cursor to that line then press F3 
and a menu of choices will appear.  Highlight a font to use and press 
<Enter>.  When you are finished, highlight the "Ok" button and press 
<Enter>.  Alternately, you can use a mouse (click on "Ok") or press F7 to 
save the screen and exit.

Laser printer soft fonts

You will need portrait (SFP) fonts for reports.  Once you define 
your font choices on this screen WVH will automatically use them for 
all reports.

Example: Highlight the "Titles Font" line and press the <F3> key 
- a window of font choices will appear.7  You may choose any of the 
built-in fonts or a soft font.  If you choose "Select a soft font," a 
window will pop open in which you may enter a drive and/or path 
which contains the soft font files (whatever you enter here becomes 
the default response for next time).  Next you will be shown a list of 

7You must define the printer before you can set any fonts.
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the soft font files (*.SFP) in that directory.  Use the arrow keys and 
PgUp/PgDn keys to move around, highlight the one you want, and 
press <Enter>.  The soft font file name will now be shown on the 
screen.

Scalable fonts

A scalable font is a single font (e.g., CG Times, Univers, etc.) 
which can be printed in practically any size.  PCL 5 printers like the H-
P LaserJet III and IV have scalable fonts built in.  This means you can 
pick a font and print in practically any size you want.

When you select a scalable font WVH will prompt you for the 
pitch (cpi) or the point size, depending on whether it is a fixed-pitch 
or proportionally-spaced font.  In general numbers between 8 and 14 
work best.  My favourite font for both my laser and dot matrix is a 
Helvetica-Univers-Swiss- etc. (sans serif) font at 12cpi or 12 points.

Lines per page

Enter the number of lines which may be printed on a page in 
your printer.  Most of the time you will be working with 66 lines total 
(11-inches of paper printed at 6 lines per inch).  On laser printers the 
total number of lines of often 60 due to half-inch top & bottom 
margins.

I recommend that you set this to 55 lines, which is a common 
setting leaving an inch margin at the top & bottom of each page.

Left margin

This setting is the same as it would be for a typewriter - it is the 
distance from the left margin, in inches, at which printing will begin.  
If you would like to leave space at the left edge (e.g., to 3-hole punch 
the pages) then set this as you wish.  If you use a 10 cpi font (or 
12 points for lasers) there will be no room for a left margin on most 
reports.  However, a 12 cpi (or 10 point) font, such as Prestige Elite, 
will give you room to set a one-inch margin or so.  Experiment to find 
what works best for you.

Sales Tax Rate and Labour Rate Entry
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This window lets you set two important items:  The sales tax rate

for your area and whether or not you want to enter the labour hourly 
rate on the Maintenance Data Entry screen.

If you do not need to track sales tax, just enter zero for this.  
Otherwise, enter your sales tax rate as a percentage (i.e., 7.50 for 
7.5%).

When you are entering service information for a vehicle you are 
asked to indicate the mechanic or place of service which, in turn, 
indicates the hourly rate for labour.  If you wish you can enter the 
labour rate on the service data entry screen, which allows you to 
over-ride the rate set for the mechanic or place of service.  This can 
be handy if you don't want to track mechanics, only the service done. 
In this case you could set up a single mechanic and enter the hourly 
rate as it pertains to each incident of service.

HELP

The Help menu contains information screens and print-outs.  This 
menu is divided into three sections:

1. The on-line manual (Index)
2. Information about how WVH is running on your computer
3. Registration, site license, and update order forms

Choosing the Index option will bring up the table of contents for 
WVH's help system.  You may then use the arrow keys or a mouse to 
highlight a choice and press ENTER (or click the mouse button) to view the 
information on the screen.  The help index contains mostly the same 
information which is displayed when you press the F1 (Help) key on data 
entry screens, plus there is additional information which is only available 
from this menu.

The About option gives you the current version number, copyright 
information, and my address & phone number.

The Files & Memory option tells you how about your computer's free
memory (RAM and disk space) and shows statistics about the opened mail 
list file (if any), group file, abbreviation file, and zip/postal code file.
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The lower three options print various order forms.  Order Form prints

an order form for registering WVH.  Site License prints a site license form 
which shows discounted pricing if you wish to use more than one copy of 
WVH at a single location.  Update/Sampler Form prints a form to use when
you want to order an update disk to the latest version of WVH - you need not
be registered to order an update disk.  If you have a version of WVH which is 
several months old please feel free to order the latest version for evaluation.

ERROR MESSAGES

WVH tries to handle most problems without any attention from you, 
however, there are times when an error happens which WVH is unable to 
handle.  There are three types of errors which you may experience:

1. Condition error - this is a problem due to an operating condition.  
Examples of this type of error are if a printer is off-line when you try to print 
or a file is locked by another user on a network.  If the condition is 
detectable, WVH will report it in a window and, once you press ENTER or click
the "Ok" button, WVH will continue operating.

2. File error - these problems cause an error screen to appear which
suggests a possible solution to the problem and, if you can't fix it, my 
address and phone number is shown so you can contact me.  Common 
reasons for this type of error are that an index file contains a bad entry 
(perhaps due to a power outage) or the disk in use contains an error.  The 
most common solution to these problems is to re-index your files (File/re-
Index).  If that doesn't work, see the section below on disk problems.

3. Programme error - this is a mistake of mine and will cause the 
programme to abruptly end with a one-line error message and a message 
like "Press any key to return to system."  Report these errors to me right 
away, please.  Just like other large software packages, WML contains 
hundreds of thousands of instructions and the bigger it gets the more likely it
is that a "bug" will creep in there somewhere.  These errors get top priority 
and are usually fixed and a new version released within a day.

All large software packages have "bugs" which are errors in the 
programming logic.  For example, many Windows uses experience "General 
Protection Fault" messages which are caused by bugs in Windows and/or 
other software which was running.  As WML goes through its evolution, bugs 
are removed; as new features are added new bugs sometimes find their way 
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into the software.  It is very helpful when someone informs me of a problem 
they found.

The following sections describe some common errors and procedures 
to correct them.

EMS Memory Error

I have discovered a problem on a Packard Bell computer which results
in WML refusing to run, giving the error message, "Not enough EMS to load 
overlays."  This error is generated by the programming language, not by 
WML itself, which has left me unable to determine its cause.  I saw the error 
happen with 250kb of free EMS memory and 0kb free XMS memory.

My best guess is that since there is some free EMS memory the 
overlay manager tries to load portions of WML into EMS, but since there is 
not enough memory it fails and is unable to revert back to operating without 
EMS memory.

There are three ways around this problem:

1. Remove the EMM386 line in your CONFIG.SYS file or change the 
"RAM" key word to "NOEMS".  Either of these actions will remove EMS 
memory support from your computer.  If there is other software in your 
computer which requires EMS to run this will not be a practical solution for 
you.

2. Change the EMM386 line to have either more or less memory, re-
boot your computer, and try to run WML again.  Experiment to find the 
memory setting which works for WML and also allows your other software to 
operate properly.

3. Change the memory settings for software which uses EMS, such as 
SMARTDRV, so that there is either more or less EMS memory available.

Text overlaps on reports

This problem is caused by choosing a font which is too large for the 
report layout - WVH has no way to detect this situation.  To resolve the 
problem go to the Preferences/Printers screen and change the font to a 
smaller (lower) point size or a more dense (higher) character pitch.
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Information is Missing - Correcting Disk Problems

I place great emphasis on keeping data safe and know of no case 
where WML has lost data, however, problems with DOS or computer 
equipment may cause data to be lost in rare circumstances.

If any of your data seems to be missing exit to DOS and type 
"CHKDSK C: /F" (without the quotation marks; replace "C:" with another 
drive, if appropriate).

MS-DOS 6.2 users:  Use the command "SCANDISK C:" since it 
performs a more thorough test.

Either CHKDSK or SCANDISK will check that the recorded location of 
each file is valid.  The SCANDISK utility can also perform a surface scan 
which tests the entire disk to be sure all areas of it are usable.

If CHKDSK or SCANDISK find any errors they will be reported to you 
and you will be asked for input on correcting the errors.  CHKDSK only knows 
how to clear any errors and turn "orphan" data into new files.  By "orphan" 
data I mean data which is on your hard disk but for which DOS has lost the 
information about the file to which it belongs.  Normally this data is not 
usable or requires tremendous effort to make it usable again.  I suggest you 
do not create files from this data unless you have lost a tremendous amount 
of data which would be very difficult to re-enter or the data is irreplaceable.  
Beyond this point you will require the help of someone who knows how to 
recover damaged files.  Contact me if you cannot find a local consultant to 
perform this service for you.

SCANDISK is able to identify bad sections of your disk and attempt to 
move data to safe areas.  If the area is badly damaged the attempt to move 
data may not be entirely successful.  If SCANDISK tells you it has found 
problems on your disk I suggest you let it fix them.  If your data is 
irreplaceable or would take a tremendous amount of effort to re-enter, then I 
recommend that you get the help of a consultant.  At the very least make a 
complete back-up copy of your data files (or the entire hard disk) so that you
can attempt to restore information in case files are so badly damaged that 
information becomes lost.

In most cases you will find that no data is missing and all you need to 
do is re-index your files for the "missing" entries to re-appear.  To re-build the
index files just select the Re-index option on the File menu.
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FILES WHICH MAKE UP THE PACKAGE

The unregistered Shareware Edition of What Vehicle History? is made 
up of the following files:

FILE_ID.DIZ * Description file for BBSs
DESC.SDI * Description file for BBSs
WVH.EXE What Vehicle History? programme
WVH.HLP Help file
WVH.MSG Screen message file
WML.MIX Screen message file index
WML.HX0 & HX1 Help file indices
WVH.SCN Screen field definitions file
WVH.TXT * Documentation in ASCII - TYPE WVH.TXT > PRN to 

print it
WVH.WP * Documentation in WordPerfect 5 format
FKEY.LST Function key definitions file
PRINTER.DAT Printer definitions file
ORDER.FRM Order form for WVH and other software
VENDOR.DOC * Information concerning the distribution of this 

software
SYSOP.DOC * Information for bulletin board sysops
READ.ME * Latest information

If you distribute evaluation copies to friends and bulletin boards please
be sure to include all of these files (additional files will be created by WVH 
which contain your data and should not be distributed unless you intend to 
share your data files).  Files marked with an asterisk (*) are not required to 
run WVH so they may be erased if disk space is a premium (such as if you 
are using WVH on a floppy disk system).

The Registered Edition contains a registration key which is contained
in the file CONFIG.WVH.  If you share WVH with friends and BBSs, please 
ERASE this file from the copies you share:
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